ENROUTE
QUICKSTITGH

with the ImageSynthesis™ engine

Introduction

Enroute Imaging's QuickStitch combines photos into
stunning wide angle panoramas in seconds.
Powerful, yet deceptively simple, QuickStitch is
designed for hand-held shots. It's the only software
that “stitches™ horizontally and vertically, and it's
automatic-forget the hassle of selecting lenses or
overlap points. QuickStitch has features unavailable
in other panorama creation software.

QuickStitch”




YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING THIS SOFTWARE. INSTALLING THIS
SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

SOFTWARE LICENSE AGREEMENT

Enroute, Inc. ("Enroute”) hereby grants 1o You, the original end user licensee. a nonexclusive, non-transferable license 10 use the copy of
QuickStitch Version 1.0 software (the "Software”) and documentation contained in this package, subject to the terms and conditions stated in thig

License and Limited Warranty Agreement ("Agreement”).
LICENSE

You may:

» install and use the Software on a single computer,

» make one (1) copy of the Software into any machine-readabte format solely for backup and archival purposes, provided
that You include all proprietary notices on such copy,

» physically transfer the Software from one computer to another, provided that the Software is removed from the computer an
which it was installed and is used only on one {1) computer at a time, and

RESTRICTIONS. You may not sublicense, assign or transfer the license to the Software or accompanying documentation except as expressly
provided in this Agreement. Any attempt otherwise to sublicense, assign or transfer any of the rights, duties or obligations hereunder is void. The
Scftware contains trade secrets, and in order to protect them, You may not decompile, reverse engineer or disassemble the Software, or otherwise
reduce the Software to a human perceivable form. You may not modify, adapt, translate, lease, toan, resell for profit, distribute, or create derivative
software based on all or any part of the Software.

TITLE. The original and any copies of the Software or accompanying documentation, in whole or in part, including translations, compilations, partial
copies, modifications, and updates are the property of Enroute. You have only the limited rights granted by this license, and shall not use the
Software except as expressly authorized herein. You are not an owner of any copy of the Software, and therefore 17 U.S.C. section 117 does not
apply. You must reproduce and include the proprietary rights notices on any copy of the Software and accompanying documentation.

TERMINATION. You may terminate Your licenses to the Software at any time by destroying the Software and accompanying documentation
together with all copies, modifications and merged portions in any form. The licenses will also terminate upon conditions set forth eisewhere in this
Agreement or if You faii to comply with any term or condition of this Agreement. You agree upon such termination to destroy the Software and
accompanying documentation, together with all copies, modifications and merged portions in any form.

LIMITED WARRANTY

Enroute warrants to You that the media on which the Software is furnished shall be free from defects in materials and workmanship under normal
use for a period of ninety (90) days from the date of purchase as evidenced by a copy of Your receipt (the “"Software Warranty”). Enroute does not
warrant that the Software or documentation will meet Your requirements or that the operation of the Software will be uninterrupted or error free.
Enroute’s entire liability and Your exclusive remedy with respect to breach of the Software Warranty will be the replacement of any media not
meeting the Software Warranty and which is returned to Enroute within the Software Warranty period with a copy of Your receipt.

EXCEPT FOR THE LIMITED WARRANTY STATED IMMEDIATELY ABOVE, THE SOFTWARE IS PROVIDED “AS 1S” WITHOUT WARRANTY OR
CONDITION OF ANY KIND, EITHER EXPRESS OR IMPLIED, AND THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT ARE SPECIFICALLY DISCLAIMED WiTH RESPECT TO THE SOFTWARE.
EXCEPT FOR THE LIMITED WARRANTIES STATED ABOVE, THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PRODUCT IS
WITH YOU AND SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT ENROUTE OR ANY AUTHORIZED DEALER) ASSUME THE
ENTIRE COST OF ALL NECESSARY CORRECTION. No oral or written information or advice given by Enroute, its dealers, distributors, agents or
employees will create a warranty or in any way increase the scope of the limited warranties set forth herein, and You may not rely on any such
information or advice. This warranty gives you specific legal rights and you may also have other rights which vary from state to state.

LIMITATION OF LIABILITY. IN NO EVENT WILL ENROUTE OR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR
DELIVERY OF THE SOFTWARE BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST
PROFITS, LOSS OF USE, BUSINESS INTERRUPTION, LOSS OF DATA OR COST OF OBTAINING SUBSTITUTE GOODS ARISING QUT OF OR
RELATING TO THE SOFTWARE, OR THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ENROUTE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. THE FOREGOING LIMITATIONS OF LIABILITY SHALL APPLY NOTWITHSTANDING ANY FAILURE OF
ESSENTIAL PURPOSE OF ANY LIMITED REMEDY STATED HEREIN. ENROUTE'S LIABILITY TO YOU OR ANY THIRD PARTY ARISING QUT OF OR
RELATED TO THIS AGREEMENT HOWEVER CAUSED AND ARISING UNDER ANY THEORY OF LIABILITY, WHETHER BASED IN CONTRACT, TORT
(INCLUDING NEGLIGENCE), OR OTHERWISE SHALL NOT EXCEED IN AGGREGATE THE AMOUNT PAID BY YOU FOR THE SOFTWARE. SOME
STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

GOVERNMENT RESTRICTED RIGHTS LEGEND. If You are acquiring the Software on behaif of any part of the United States Government, the
following provisions apply. The Software and accompanying documentation are deemed to be “commercial software” and “commercial computer
software documentation,” respectively, pursuant to DFAR Section 227.7202 and FAR 12.212(b), as applicable. Any use, modification, reproduction,
release, performance, display or disclosure of the Software and/or the accompanying documentation by the U.S. Government or any of its agencies
shali be governed solely by the terms of this Agreement and shall be prohibited except to the extent expressly permitted by the terms of this
Agreement. Any technical data provided that is not covered by the above provisions is deemed to be “"technical data-commercial items” pursuant
to DFAR Section 227.7015(a). Any use, modification, reproduction, release. performance, display or disclosure of such technicat data shall be
governed be the terms of DFAR Section 227.7015(b).

MISCELLANEQUS. This Agreement constitutes the complete and exclusive understanding an agreement between Enroute and You relating to-the
subject matter hereof and supersedes all prior or contemporaneous understandings, agreements, and communications, and/or adverlising with
respect to such subject matter. This Agreement cannot be amended, modified, or waived, unless done so in writing and signed by an autharized
Enroute representative. If any provision of this Agreement is held unenforceable, that provision shall be enforced to the maximum extent
permissible so as to give effect the intent of the parties. and the remainder of this Agreement shall continue in full force and effect. This Agreement
is governed by the laws of the State of California, without reference to its conflict of law principles. You agree to comply with all U.S. and foreign
export control laws and reguiations.

© Copyright 1997 Enroute Imaging.All rights reserved.953 Industrial Ave., Suite 111, Palo Alto, CA 94303
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Enroute Quickstitch

Minimum System Requirements

Macintosh Version
System 7.5 or later

Windows Version

Operating system: Windows 95/98

or NT 40
Processor: Pentium Power PC
RAM: 16M8B 20M8B, virtual
memory on
Screen colors: 256 256
Screen resolution:  800x600 sugg.. 800x600 sugg.,
640x480 min B840x480 min.
Disk space: 30MB 36MB
(for software)
TABLE OF CONTENTS
Getting Started 5.1
Proper Picture-Taking 53
Source Picture Requirements 53
Start Using QuickStitch 53

Stitching Step 1 - Find Images

Stitching Step 2 - Moving Files to the
Image Grid

Stitching Step 3 - Making a Panorama
(Stitching)

Stitching Step 4 - Pancrama Viewer
Window

Viewing the Panorama
Zooming the Panorama
Cropping the Panorama
Rotating the Panorama
Enhancing the Panorama
Saving the Panorama
Printing the Panorama
55
57

Frequently Asked Questions
Technical Support

51

GETTING STARTED
Windows Installation:

1) Insert Disk 1 of the Digital Image Productivity
Software Suite.

2y Click the Start menu and select Run.

3) Click on Browse, then double-click on the
QuickStitch folder.

4) Click on Setup.exe, then click open.
5) Click on OK to begin installation.
6) Follow the prompts in the installer.

Using QuickStitch:

A QuickStitch short cut icon will be installed under
"Programs” in the Windows 95 Start Menu. To access
it, press Start, Programs, QuickStitch.

To run QuickStitch directly from the CD-ROM:
1) Choose Run on the Windows 85 Start Menu

2) Type D:NQSTITCH.EXE and press Enter (replace D:
with the letter of your CD-ROM drive if it is not D).

If QuickStitch is running from the CD-ROM, it will be
much slower than the installed version.

Macintosh Installation
e PowerPC Required

* QuickStitch for Macintosh works only on Macintosh
computers with PowerPC microprocessors

1) Insert your Digital Image Productivity Software Suite
into your CD-ROM drive.

2) Double-click on the folder containing QuickStitch.
3) Double-click on the QuickStitch icon.

4) Follow the on-screen instructions.

Special Notes for Macintosh Users

Locating Sample Images

Included with this distribution is a set of sample
images. When QuickStitch starts, the file finder
component of QuickStitch will be viewing the desktop
directory. Use this tool to navigate to the Sample
Images directory. This directory will be located on
your CD or in the location to which you copied the CD
distribution.

Macintosh Memory Consumption

Unlike traditional image processing applications that
operate on a single image at a time, QuickStitch must
operate on several images at once to produce a
pancrama. Depending on the size and number of
input images and the quality of output desired,
QuicksStitch's memory requirements range from
modest to substantial. The recommendations
contained herein apply only to Mac-style computers
(PC's running Windows 95 have virtual memory on by
default).

The basic memory recommendations are simple and
are summarized as: -




Turn on virtual memory and set it to at least 20 MB
above your real memory

If QuickStitch fails because of lack ot memory anytime
other than during a stitch operation, increase the
memory allocation in the preferences dialog box

Unless you have a lot of memory in your system (more
than 30 MBytes), you should turn on virtual memory
and set the amount of virtual memory to at least 20
MBytes more than your real (installed) memory. Note
that if you are running Connectix RamDoubler, it is not
possible to turn on virtual memory. [n this case
RamDoubler acts in much the same way as virtual
memory.

QuickStitch can run out of memory in two ways. First,
the user interface can run out of memory if the grid
contains many images or particularly large images.

It can also happen if you have generated several
panoramas that are sitting open in their viewer
windows. The second way QuickStitch can run out of
memory is during the panorama generation process
(after you hit the “Stitch” button and before a
panorama is displayed).

The first step in both situations is to access the
Memory control panel, make sure virtual memary is
turned on and turn up the size of the virtual memory
(see your computer’'s documentation for advice on
virtual memory). You will have to restart your machine
if virtual memory is not already turned on. Having
given yourself more virtual memory, if you run out of
memory while in the user interface (before pressing
“Stitch”), then bring up the Get Info box and increase
the memory preference.

Keep in mind that the Mac system itself may be using
anywhere from 10 to 15 MBytes. If you don't use
virtual memory, you will need to add QuickStitch's
requirement (explained below) to the requirements of
the Mac system and all other currently-running
programs to obtain the amount of real memory
needed.

Some settings within QuickStitch also affect memory
consumption. In the Stitch Options dialog box, you
can select either "Gradual" or "Sharp” blending. Sharp
blending takes substantially more memory than does
Gradual blending. Another option in this dialog is
output image size: selecting a larger size will
frequently result in more memory consumption. For
more details, see the Help topics regarding Stitch
Options.

This version of QuickStitch has a preset memary
preference of 15 MBytes (with a minimum requirement
of 8 MBytes). This preference has been set high
enough to accommodate the sample images, which
range from 320x240 to 1024x768 pixels in size. This
amount ot memory is sufficient to stitch all included
images at medium resolution using gradual blending.
it is also sufficient to generate many, but not all, of the
panoramas at large output resolution.
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Other strategies for dealing with low memory include:
« reduce the output resolution (in Stitch Options)

= use gradual blending (in Stitch Options)

¢ include fewer input images

* reduce the size of any RAM disk(s) in use

* close some viewer (output) windows

* close other applications that are running on your
computer and taking up memory. Note that
QuickStitch's own demo programs and help windows
count as other applications. Quit these if memory is a
problem.

Processing Speed
Processing speed is affected by:

* clock speed of your microprocessor
e number of included images (the more, the slower)

* resolution of the input images (the higher, the
slower)

* type of output projection (cylindrical is slightly
slower than perspective)

¢ size of the output image (the larger, the slower)
e stitching options (sharp blending is slower than
gradual blending)

The panorama generation process is extremely
floating point intensive. Newer computers with better
floating point performance will see a significant
improvement in performance over those with
mediocre floating point capability.

Known Incompatibility
Occasional crashes have been observed when the
following Macintosh programs are turned on:

¢ Balloon Help
* PlainTalk (speech recognition and text-to-speech)

If you experience problems, turn these off when
running QuickStitch.
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PROPER PICTURE-TAKING
Below are a few tips to remember when taking
panoramic pictures.

The process of generating panoramas matches
elements in ane picture with those in another. These
suggestions ensure that there are enough comman
elements between scenes.

1. Stand in one spot and rotate camera around
one position

2. Hold camera close to the eye for best resuits

3. Be at least 15 ft. from subject (closer shots work
best with a tripod)

4. Avold scenes with lots of motion, such as moving
cars or people

5. Hold camera level to avoid tilting and blurring

6. Overlap image pairs 50% or more (as shown
below).

When shooting large scenes, take photos in this
seguence to ensure proper overlap.

SOURCE PICTURE REQUIREMENTS

Below are the requirements for all source images
used in making panoramas. Please note that
although QuickStitch is designed for stitching hand-
held images, a tripod will usually result in better
stitching resuits.

Pictures must be taken with a digital camera or
scanned from a photograph. if images are scanned,
the center of the scanned image should remain at the
center of the original image. In other words, it is not a
good idea to use an off-center crop of a scanned
image.

* Pictures must be in BMP or JPG format.

* Pictures must ALL be the same size.

* Pictures must ALL be shot at the same level
of zoom.

Pictures should overlap by 50% or more. Good results
can often be obtained with overlaps as low as 35%,
but in general, the more overlap the better. In other
words, overlapping a pair of images by, say, 65% will
almost always work better than overlapping an image
pair by 35%.

Each picture must be taken from the same location
and with the camera in roughly the same position.
See here for more tips on taking perfect pictures.

Phaotos should also be relatively free of camera-
caused distortion. For instance, fisheye lenses cause
severe bending and elongating at the edges and
cannot be used.

Scenes should be “interesting,” i.e. should have some
structure that QuickStitch can use to determine where
they overlap. For example, pictures of a blue sky or
open ocean have little to discern one area from
another.

The camera should be held relatively level when
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taking pictures. For scenes closer than 15 feet away,
use a tripod for best results.

START USING QUICKSTITCH
Step 1 - Find Images

Using the "Find Images” box left of the grid, navigate
to the folder(s) containing images to stitch. The
current folder is shown in the upper box, and
available image files are listed in the lower box.

Navigation

Use the dropdown list in the upper box to quickly
navigate between distant folders and drives, or
double-click on folders in the lower box to move to
adjacent folders.

Image Preview

You can see a preview of any supported image by
highlighting its filename with the mouse. The preview
will appear in the Image Preview Area next to the grid.

Step 2 - Moving Files to the Image Grid

Before stitching, you must re-assemble the panoramic
scene on the Image Grid. Place the images you want
to stitch on the grid by dragging or adding them:

Dragging

Click on an image filename with the left mouse button.
A preview of that image will appear in the Image
Preview Area. Drag the filename into any grid cell by
holding the left button and moving the mouse to the
grid. Release the mouse button to drop the image
into place. Note that you can begin dragging even
before the preview image appears.

Drag and Drop

QuickStitch supports drag and drop from other folders
and programs. To drag images into QuickStitch,
select them with the left mouse button and drag them
onto the QuickStitch grid.

Adding

Click on an image filename with the left mouse button.
A preview of that image will appear in the Image
Preview Area. Then push the button to place a copy
of that image on the grid. Note that you can push
before the preview image appears.

Removing

To remove an image from the grid, select it and press
the button. Pressing will not delete the image file.
Press the button to remove all images and start over.
Click here to learn how to arrange images on the grid.
Click here to learn how 10 resize the grid. )
Step 3 - Making a Panorama (Stitching)

Once the originai scene has been reassembled on the
Image Grid, push the button to create the panarama.

When the button is pressed, a status bar indicates
stitching in progress. To stop stitching in progress,
push the Cancel button.

Generally, more images require more time, but the




total stitching time depends on many other factors
including:

a. number of input images

b. input image size and resolution

. available computer memaory

d. hard disk space and swap file size

e. blending style and projection type selected

When stitching has completed, the panorama
appears in a separate Viewer Window.

Stitching Options

A number of options are available which have a
significant impact on how your panorama is
generated. Prior to stitching, push the button to
choose how images are to be stitched and displayed.

Step 4 - Panorama Viewer Window

The panorama Viewer Window displays the stitched
panoramic result. If the panorama doesn't fit in the
Viewer Window, use the scrolibars to move around the
scene or press one of the buttons on the toolbar.

If your panorama doesn't look right, try changing the
stitching options or check the Frequently Asked
Questions list.

Viewing the panorama
Commands under the View menu let you define
window size and select various levels of zoom.

Zoom 1:1 - resizes the pancrama to its original size.
If Large or Extra Large output image size is selected,
the panorama may not fit in the Viewer Window.

Fit Image To Window - shrinks or expands the
panorama to fit snugly in the Viewer Window. For
other zoom levels, use the buttons on the Viewer
Window toolbar.

Zooming the panorama

Use the buttons on the toolbar to view your
panorama at different levels of magnification. To view
the panorama at its actual size, select Zoom 1.1 from
the View menu in the Viewer Window.

To shrink or expand a panorama to fit snugly in the
Viewer Window, select Fit image To Window under the
View menu.

NOTE: Zooming affects only the view of the image—
it does not change the actual size of the panorama.

Cropping the panorama

Cropping allows you to create rectangular output
images by cutting away unwanted portions of a
panorama. To crop your panorama:

Push the button on the toolbar or select Show Crop
Rectangle Outline from the Edit menu. The crop
region appears as a rectangular dotted line with red
"grab handles" at the sides and corners.

Move the entire crop region without changing its
shape by selecting and dragging on or within the
dotted lines.

Resize the crop region using the “grab handles” on
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each corner and side. When the mouse pointer is
moved over a grab handle, the pointer turns into a
double arrow. Hold down the left mouse button and
drag the crop outline's shape into place.

When ready, push the button on the toclbar or select
Crop on the Edit menu.

Select Undo from the Edit menu to bring back the
cropped portion.

Rotating the panorama

There are two ways to rotate your panorama before
cropping, printing or saving it. The panorama can be
rotated in small increments using the toolbar at the
bottom of the Viewer Window. Qr, use the Image menu
option to make 90, 180 or 270 degree clockwise
rotations.

Small Rotations
To rotate a panorama by roughly 2 degrees in either
direction, use the buttons on the toolbar.

Large Rotations

Automatic clockwise rotations of 90, 180 and 270
degrees are accessible under Rotate on the Image
menu.

Flip and Reverse
To flip the panorama upside down, push the button on
the toolbar or choose Flip from the Image menu.

To view the panorama “backwards,” i.e. from the
reverse side, push the button on the toolbar or select
Reverse from the Image menu.

Sharpening the pancrama

Besides rotating and cropping, QuickStitch lets you
enhance a panorama by “sharpening” the picture
contrast.

To add sharpening to your panorama:

Select Sharpen from the Image menu. Choose the
desired level of sharpening and press OK.

To cancel the sharpened effect, choose Undo from
the Edit menu.

NOTE: This function is not available in the Macintosh
version.

Step 5 - Saving the panorama

To save your panorama as a separate image file,
select Save As from the File menu or press on the
Viewer Window toolbar.

Choose the desired file type from the "Save as type”
box and enter a filename in the "File name” box. The
appropriate filename extension (BMP or JPG) will be
added if you do not specify it.

For all file types, the size of the resulting image file wilt
depend on the output image size chosen in stitching
options and how much of the pancrama was cropped
prior to saving.

If JPG file type is selected, you will be prompted to
choose an image quality from 1 to 10. Lower
numbers will use more JPG compression, thereby

ﬂﬂﬂ.ﬂﬂﬂﬂﬂﬂﬂﬂﬂHHHHHHHHHHHHHHHHHHHHi

|




creating a smaller file. Larger numbers will compress
the image less but generally preserves better image
guality.

Step 6 - Printing the panorama

Panoramas can be printed on any printer that
supports Windows 95, although best results will be
obtained from laser and color printers.

To print, select Print from the File menu or press
CTRL-P on the keyboard. Select the desired printer
(and options, if necessary) and choose OK to send
the image to your printer. Press Close to return to the
panorama Viewer Window.

To set printing options, select Print Setup from the File
menu.

FREQUENTLY ASKED QUESTIONS (FAQ)

Q. My panorama doesn't look very good. BRIEFLY,
what can [ do about it?

« |f objects in your panorama are blurry, try using
Sharp blending.

* |f the exposure looks different between matching
images, try using Gradual biending.

» |f parts of the panorama seem out of place, you may
not have arranged pictures properly on the grid.

« |f the edges expand into a “bow-tie” effect, trying
using Cylindrical projection.

See below if you're experiencing other effects. ..

Q. My pictures didn’t stitch together well. What can
I do about it?

If stitching isn't seamless, it is aimost always because
the input images do not fit together well. This is
generally due to one or more of the following:

* Not enough overlap between successive photos — at
least 30% overlap is usually required, and best results
are obtained with around 50%.

® Too much movement of the camera between shots —
the camera should stay in one position if possible.

* Images are out of order - click here for an easy way
to check for directional continuity.

» Camera was held too far from the eye, resulting in
too much arm movement between shots (and
therefore too much camera movement).

* Too much tilt on the camera between shots - the
camera should be held relatively level to avoid tilt and
blur.

* Not enough structure in the scene — scenes
containing, for example, lots of blue sky, water or
nondescript grassy fields don't have enougn
information for QuickStitch to match up corresponding
image components.

* Movement in the scene, especially at the edge of
one or more photos - if movement occurs at a critical
place of overlap, QuickStitch may be unable to
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determine how photos fit together.

+ Different zoom levels in the same scene - if your
camera has a zoom lens and the zoom was changed
while taking shots for the same panorama, QuickStitch
will be unable to stitch your pictures.

So what can | do about it? Try using Sharp biending
in order to eliminate ghost images and some overiap
errors. The panorama may not be perfect, but you
may be able to touch it up with photo-editing
software.

Also, some problems can be corrected by eliminating
one or two photas from the scene. Try experimenting
by removing photos that may not fit well with others.

Q. Stitching didn’t work at alf. What can | do
about it?

If stitching fails completely, there are three
possibilities:

1. Source images did not fit together well (see above
for reasons why).

2. Exposure was very different between matching
images, and QuickStitch was unable to determine
how they fit together.

3. A fisheye lens (or other distortion-causing lens) was
used.

Q. So what can | do about it?

Unfortunately, the only option is to take another set of
photos, this time following the hints on proper picture-
taking.

Q. Why does my panorama appear blurry or have
ghost images?

Your input images do not fit together well, or there
was movement in the scene while you were taking
photos. Try using Sharp blending under Stitch
Options to correct this. See also the picture-taking
tips for hints on avoiding these problems.

Q. Horizontal lines seem to curve away from the
camera. Why?

This is an effect of Cylindrical projection, which is best
for horizontal scenes with a wide field-of-view. Select
Perspective projection under Stitch Options to
eliminate this effect.

Q. | see a "bow-tie effect” that looks funny. Why?
This is an effect of Perspective projection over a wide
field-of-view. In order to preserve straight lines over
the entire panorama, QuickStitch must “stretch” the
edges a bit. Select Cylindrical projection under Stitch
Options to eliminate this effect.

Q. How close can | be to elements in my scene?
We recommend that you stay at least 15 feet from
your subject, but this is just an approximation —
sometimes it is OK for scene elements to be closer.
The 15-foot rule is designed to lessen an effect known
as motion parallax. Motion parallax occurs when, by
virtue of rotating your camera between shots,
elements in the scene are uncovered or hidden by
foreground elements. This is less likely to happen
when using a tripod.




Q. Can | take pictures indoors?

Yes, but since indoor shots generally include nearby
objects, it becomes even more important tc hold the
camera level and rotate it around one paosition.
Motion parallax, described in the FAQ topic above, is
generally more of an issue as well. Follow these finks
for more information on taking good pictures and
possibly using a tripod.

Q. 1ran out of memory or crashed while running
QuickStitch on the Mac. What do | do?

QuickStitch can run out of memory In two ways. First,
the user interface can run aut of memory if the grid
contains many images or particularly large images.

It can also happen if you have generated several
panoramas that are sitting open in their viewer
windows. The second way QuickStitch can run out of
memory is during the panorama generation process
(after you hit the “Stitch” button and before a
panorama is displayed).

The first step in both situations is to access the
Memory control panel, make sure virtual memaory is
turned on and turn up the size of the virtual memory
(see your computer’'s documentation for advice on
virtual memory). You will have to restart your machine
if virtual memory is not already turned on. Having
given yourself more virtual memory, if you run out of
memory while in the user interface (before pressing
“Stitch™), then bring up the Get info box and increase
the memory preference.

Other strategies for dealing with low memory include:
reduce the output resolution (in Stitch Options)

. use Gradual blending (in Stitch Options)

include fewer input images

reduce the size of any RAM disk(s) in use

close some viewer (output) windows

. close other applications that are running on your
computer and taking up memory

Q. How do | get pictures into my computer?

If you are using pictures from a digital camera, see
the manufacturer's instructions on loading these
pictures onto your computer. This generally involves
some software (and perhaps cables) that came with
the camera.
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Q. But what if I'm using scanned images?

To scan regular photographs, refer to the scanner
manufacturer's instructions. Once your scanned
images have been saved to disk in BMP or JPG
format, QuickStitch can use them.

Q. It's hard to tell how my pictures should be
arranged before stitching. Is there an easy way to
check?

With a series of images that look a lot alike, it is easy
to misalign them in the grid. A quick way to check for
directional continuity is to click on the upper left
image in the grid, hold down the CTRL key, and use
the arrows keys (up, down, left, right) to scrofl through
the images in the grid. You should see continuous
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motion (left to right or top to bottom) in the Preview
Area as you scrolf through the images.

Q. How should | take pictures?
See here for a complete explanation, or see here for a
visual demonstration.

Q. Should | be using a tripod?

A tripod generally produces better input photos (and
therefore better panoramic results) because it reduces
the amount of camera movement between shots, but
it is not required unless you are within about 15 feet of
the scene. QuickStitch is designed to work well with
hand-held shots, provided some simple guidelines are
followed.

Q. What if | have more than 4 images across (or
up and down)?

Enlarge (zoom out) the grid. You can have up to 6
images in any direction.

Q. What if | have more than 6 images across (or
up and down)?
QuicksStitch supports only 6 images in any direction.

Q. What is the maximum field-of-view | can stitch?
The maximum for Perspective projection is 120
degrees, but a Cylindrical projection can go as far
around as you want. However, over a wider field-of-
view it becomes more important not t¢ reposition the
camera between shots. See here for tips, or use a
tripod for very wide shots.

Q. Where are my source pictures (the pictures {
want to stitch)?

Pictures imported from a digital camera are often
saved into the folder holding the camera software.
Use the Find Images box to navigate to the folder
containing your camera software, or use Windows'
Find command (on the Start menu) 1o locate your
files. Then, navigate to your images in QuickStitch
using the Find Images area.

Q. | can't see certain image files in the Find
Images file list. Where are they?

QuickStitch supports only Windows Bitmap and
JPEG images that end with BMP and JPG filename
extensions, respectively. Files of other types will not
show up in the Find Images window.

Q. When ! click on a filename, an image appears in
the image Preview Area, but when | try to move
that image onto the grid, nothing happens. What's
going on?

You can't drag images out of the Preview Area.
instead, drag images into the grid from the Find
Images area or from the desktop. Use the Preview
Area to see images by clicking on a filename (or grid
image).

Q. The image preview does not appear in the
Preview Area, or it appears as a black square.
QuickStitch is experiencing a rare conflict with your
graphics display adapter, which usually happens only
in 256 colar mode. Try the following in order until the
problem is solved:

1. change the display mede to 16, 24, or 32-bit color
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depth using the Display icon in the Control Panel

2. switch your graphics adapter setting to standard
VGA or Super VGA using the Display icon in the
Control Pane!

3. if you know where your images go, the fact that
they show up black in the grid does not affect
stitching or the dispiay of the output. If the above
steps don't work, a final workaround is simply to
ignore it

Q. How many viewer windows can be open at
once?

Up to 9, and each window can contain panoramas
made from different image sets.

Q. | got an error message. What does it mean?
See the Error/Warning Messages section of the
QuickStitch on-line help file for a description of each
message.

Q. I'min the viewer window (looking at the
panorama), but how do I get back to the first (grid)
window?

The grid window is always present. it may, however,
be hidden under the viewer window or other windows
on the computer desktop. it also may be minimized
to the taskbar (PC only). To show the grid window,
adjust the position of other windows or maximize it
from the taskbar.

57

TECHNICAL SUPPORT

Technical support is available to registered users
Monday through Friday between 8:00am and 5:00pm
Pacific Time.

Before you call

Our experience has shown that most questions are
answered in one or more of the following resources.
Please review them betore calling for support

Frequently asked questions - includes reasons why
pancramas may not look right and how to improve
results

Taking pictures correctly - a short but detailed
explanation included in this manual

Taking pictures correctly - a visual demonstration
included on your QuickStitch CD

How to use QuickStitch - a visual demanstration
included on your QuickStitch CD

What QuickStitch can do - a visual demonstration
included on your QuickStitch CD

Examples - a tutorial with example photos and
explanations of stitching options included on your
QuickStitch CD

Information to have ready before calling:

Please have the following information available before
calling. This makes it easier for us to diagnose your
problem and will shorten the length of your call.

1. version of QuickStitch (found on the Help contents
page)

2. operating system - Windows 95/98, Windows NT
4.0, or Macintosh PowerPC

3. computer brand and model

camera model number

size and number of input images
amount of RAM

other applications running at the time

NO O oA

You may reach live technical support operators by
calling (503) 684-3142. Please note that this is a toll
call within the United States and Canada.




